Authoring Tools
Photoshop

Layers

Layers allow you to work on one element of an image without disturbing the others. Think of layers as sheets of acetate stacked one on top of the other. Where there is no image on a layer, you can see through to the layers below. You can change the composition of an image by changing the order and attributes of layers. In addition, special features such as adjustment layers, fill layers, and layer styles let you create sophisticated effects.
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Illustration of how transparent areas on a layer let you see through to the layers below

Layers palette

The Layers palette lists all layers, layer sets, and layer effects in an image. You can accomplish many tasks--such as creating, hiding, displaying, copying, and deleting layers--using the buttons in the Layers palette. You can access additional commands and options in the Layers palette menu and the Layers menu.
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Photoshop Layers palette: A. Layers palette menu B. Layer set C. Layer D. Layer thumbnail E. Layer effect

Expanding and collapsing layer sets

Click the triangle to the left of a layer set folder. In Photoshop, press Alt (Windows) or Option (Mac OS) when clicking the triangle to expand or collapse all effects applied to layers contained within the set. In ImageReady, press Alt (Windows) or Option (Mac OS) when clicking the triangle to expand or collapse all sets.

Creating layers and layer sets

A new image in Photoshop or ImageReady has a single layer. The number of additional layers, layer sets, and layer effects you can add to an image is limited only by your computer's memory. 

Background Layer

When you create a new image with a white background or a colored background, the bottommost image in the Layers palette is Background. An image can have only one background. You cannot change the stacking order of a background, its blending mode, or its opacity. However, you can convert a background to a regular layer.

When you create a new image with transparent content, the image does not have a background layer. The bottommost layer is not constrained like the background layer; you can move it anywhere in the Layers palette, and change its opacity and blending mode.
Working with layered images

There are many advantages to working with layered images. You can quickly select, hide, duplicate, lock, and change the appearance of images using layers. 

Merging layers

When you have finalized the content of layers, you can merge them to create partial versions of your composite image. The intersection of all transparent areas in the merged layers remains transparent. Merging layers helps manage the size of image files.

In addition to merging layers, you can stamp layers. Stamping allows you to merge the contents of more than one layer into a target layer while leaving the other layers intact. Typically, the selected layer will stamp down to the layer below it.

Flattening all layers

In a flattened image, all visible layers are merged into the background, which greatly reduces the file size. Flattening an image discards all hidden layers and fills the remaining transparent areas with white. In most cases, you won't want to flatten a file until you have finished editing the individual layers. 
Layer blending mode
A layer's blending mode determines how its pixels blend with underlying pixels in the image. You can create a variety of special effects using blending modes such as: Dissolve, Behind, Darken, Multiply…
Using filters

To use a filter, choose the appropriate submenu command from the Filter menu. These guidelines can help you in choosing filters:

· The last filter chosen appears at the top of the menu. 

· Filters are applied to the active, visible layer. 

· Filters cannot be applied to Bitmap-mode or indexed-color images. 

· Some filters only work on RGB images. 

· Some filters are processed entirely in RAM.
Artistic filters
Achieve a painterly or special effect for a fine arts or commercial project. 

Blur filters

Soften a selection or an image. Blur filters are useful for retouching. 
Distort filters

Geometrically distort an image, creating 3D or other reshaping effects.
Sharpen filters

Focus blurry images by increasing the contrast of adjacent pixels.
Texture filters

Give images the appearance of depth or substance, or add an organic look. 

Selections

Selections options bar

   In the options bar, specify whether to add a new selection [image: image3.png]


, add to an existing selection [image: image4.png]


, subtract from a selection [image: image5.png]


, or select an area intersected by other selections [image: image6.png]


.

Anti-aliasing 

Smooths the jagged edges of a selection by softening the color transition between edge pixels and background pixels. 
Feathering 

Blurs edges by building a transition boundary between the selection and its surrounding pixels. 
Toolbox overview
* Photoshop only

§ ImageReady only
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The marquee tools make rectangular, elliptical, single row, and single column selections.
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The move tool moves selections, layers, and guides.
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The lasso tools make freehand, polygonal (straight-edged), and magnetic * (snap-to) selections.
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The magic wand tool selects similarly colored areas.
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The crop tool trims images.
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The slice tool creates slices.
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The slice selection tool selects slices.
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The healing brush tool * paints with a sample or pattern to repairs imperfections in a image.
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The patch tool * repairs imperfections in a selected area of an image using a sample or pattern.
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The brush tool paints brush strokes.
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The pencil tool paints hard-edged strokes.
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The clone stamp tool paints with a sample of an image.


Premiere

Importing Clips

  You can import clips into Premiere as a single clip, multiple clips, or an entire folder of clips directly into the Project window. If you want to examine a clip before importing it into the project, open the clip in a Clip window and then move the clip to the Project or Timeline window. 

Using the Timeline window

The Timeline is a time-based view of your program where you can select, arrange, and modify the instances of the source clips you've used in the video program. The Timeline graphically shows the placement of each clip in time, its duration, and its relationship to the other clips in the program.
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A. Work area markers B. Preview indicator area C. Work area bar D. Edit line marker E. Work area band F. Timeline window menu G. Selection tool H. Superimpose Track I. Toggle Track Ouput icon J. Video 1 tracks K. Audio track L. Track Header buttons M. Lock icon N.Time Zoom Level popup O. Track Options Dialog button P. Toggle Snap to Edges button Q. Toggle Edge Viewing button R. Toggle Shift Tracks Options button S. Toggle Sync Mode button 

Transitions

Premiere includes over 75 transitions, which you choose from the Transitions palette. Within the palette, transitions are organized by type, in folders. Each transition is represented by an icon depicting how it works, To add a transition, place it in the Timeline window between two clips. Transitions can be applied only to clips on the Video 1 tracks. You can also click the default transition button in the Monitor window (or use keyboard shortcuts in the Monitor or Timeline windows) to apply a default transition 

Title

Even though you can create a title while working in a project, a title is an independent file, separate from your project. Like any other clip, it doesn't become part of your video program until you add it to the Timeline. You can work with more than one open Title window at a time, or use a title in more than one project.

Superimposing and Composting (Creating Transparency)

In video or film, transparency allows one clip to show through another, creating composites, transitions, or special effects. The opacity of a clip or portion of a clip determines its level of transparency. At 100% opacity, an image contains no transparency at all; at 0% opacity, the image is completely transparent, allowing other clips to show through. At other percentages, the image is partially transparent, allowing other underlying images to be visible at the same time. The brightness values of a clip's alpha channel, an additional grayscale or monochrome channel in an RGB image, also determine the clip's opacity.

Using the Video Opacity rubberband

When you place a clip in a superimpose track, an Opacity rubberband, appears beneath it (you must expand the superimpose track to display the Opacity rubberband). The Opacity rubberband specifies the opacity of the entire clip. By adding handles, you can adjust the opacity of a clip. The Opacity rubberband adjusts opacity after any keys have been applied. In other words, moving the Opacity rubberband adjusts the opacity for opaque, transparent, and semitransparent regions in the clip. To adjust fading:

1- Place a clip in a superimpose track. If necessary, click the triangle to the left of the track name to expand the track, or Option-click (Mac OS) or Alt-click (Windows) the triangle to expand all the superimpose tracks at once.

2- Click the red Display Opacity Rubberbands icon to display the opacity rubberband.
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Using keys to superimpose and create composites 
Adobe Premiere provides 15 keys (methods for creating transparency) that you can apply to a clip to create transparency in many different ways. You can use color-based keys for superimposing, brightness keys for adding texture or special effects, alpha channel keys for clips or images already containing an alpha channel, and matte keys for adding traveling mattes or creative superimpositions. To apply a key to a clip:

1- Select the clip in a superimpose track (Video 2 or higher).

2- Choose Clip > Video Options > Transparency.
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3- Choose a key from the Key Type menu.

Using the Chroma key type

   Use the Chroma key to select a color or a range of colors in the clip to be transparent. You can use this key when you have shot a scene against a screen that contains a range of one color, such as a shadowy blue screen. Select a key color by clicking the color swatch or by using the eyedropper to choose a color from the thumbnail beneath the color swatch; use the slider bars in the dialog box to adjust the color that you want to key out.  Adjust the following Chroma key settings as necessary

Using the RGB Difference key

   The RGB Difference key is a simpler version of the Chroma key. You can select a range of color, but you cannot blend the image or adjust transparency in grays. 

Using the Blue Screen and Green Screen keys

   The Blue Screen and Green Screen keys create transparency from true chroma blue and true chroma green. 

Using the Luminance key

   The Luminance key creates transparency for darker values in the image, leaving brighter colors opaque. 

Using the Multiply and Screen keys

   The Multiply key creates transparency in the areas of the image that correspond to the bright areas in the underlying image.

Image Matte

Areas of black in the still image become fully transparent in the clip, and areas in the image that are between white and black produce varying levels of transparency in the clip. 

Using effects in Premiere

  You can add any effect to a clip at any time. If you don't like an effect, you can easily delete it. You can even apply the same effect multiple times to the same clip with different settings. For example, you can add multiple instances of the Equalize audio effect for situations when you would chain together multiple equalization hardware modules in a conventional audio studio. By default, when you apply an effect to a clip, the effect is active for the duration of the clip. However, you can make the effect start and stop at specific times, or make the effect more or less intense over time, by using keyframes. 

Understanding keyframes

Premiere uses keyframes to change an effect over time. A keyframe contains the values for all the controls in the effect and applies those values to the clip at the specified time. By default, once you apply an effect to a clip, Premiere creates a beginning and ending keyframe with the same value, but by applying different values to keyframes, you can change an effect over time. Premiere automatically interpolates the values of the controls between the keyframes, using a linear progression. This means that you don't have to create a keyframe for every frame in the clip. For example, suppose that you wanted to use the Crystallize effect and have it increase and then decrease over time. In this case, you would need to set three keyframes--the first with light crystallization, the second with more significant crystallization, and the third with light crystallization. Because Premiere automatically interpolates the distortion between each keyframe, the crystallization will gradually increase (linearly) between the first and second keyframes and then gradually decrease between the second and third keyframes.

Note: Some Premiere effects are not keyframeable and cannot be animated.

Working with keyframes

To modify effect settings with keyframes, create keyframes in the keyframe line of the Timeline window. You can then adjust the effect's controls for each keyframe in the Effect Controls palette. 
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A. Effect keyframe button B. Keyframe navigator C. Effect pop-up menu D. Keyframe line
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A. Effect Enabled button with the stopwatch icon visible B. Keyframing Enabled button C. Effect name D. Effect controls

Video effects included with Premiere

Adobe Premiere includes a variety of video effects designed to alter or enhance the appearance of video images. 

Transform

  This effect applies two-dimensional geometric transformations to a clip. Use the Transform effect to resize,  skew or change a clip position.

Black & White

  This effect converts any color clip to grayscale; that is, colors appear as shades of gray. You cannot keyframe this effect.

Channel Mixer

Basic 3D

Color Balance

Crystallize

Emboss 

Flash MX

Timeline

· The timeline is made up of many frames shown in chronological order.

· It provides easy access to all frames within your scene.

· To add things to specific pages, you will need to add a key frame.

Layers

· Layers are transparent sheets that can be edited without affecting another layer.

· They are a basic part of Flash and are used much in the say way as they are in Photoshop.

· They enable overlapping drawings, as well as simultaneous tweens and effects.

· They appear on the timeline.

· Objects can be placed on upper layers to hide objects underneath.

· Make sure that you are working on the correct layer before you work on the object itself.

· To create a new layer:

· Go to the Insert Menu, and choose Layer.

· To select a layer:

· Click the layer name.

· Moving layers:

· Click and drag the layer either above a layer or below a layer.

· Name a layer:

· Double click the instance name.

· Delete the current name.

· Type a new name for the layer.
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 Information Box

· Gives you information on the height and width of an object

· Gives you the X and Y coordinates for an object on the stage

Property Inspector:

·     Context Sensitive 

·     Displays settings for what you have selected as an object or a Frame.

Stage:
· The stage is where the flash movie is displayed.

· Think of it as the screen that projects your movies.

· The work area is everything around the stage.

Panels:

· They contain tools that allow you to organize, view, and modify elements in a movie.

· Panels are the option menus in Flash.

· They hold information about the objects.

· They are what you use to manipulate the objects.

· To show a panel, choose Window ( Panels, and then choose the panel.
Toolbox:

· Flash is not a graphics design tool.  Macromedia Fireworks and Adobe Photoshop are graphics design tools.  Flash will do a good job with graphics but they are not its primary function.

· The toolbox contains the tools for drawing, editing, and adjusting graphics

· Choose Window(Tools to access the toolbox.
· The Color Tray allows you to change both line and fill colors.

· The Options Tray displays the different options for the various tools.

· Example tools:

· The Paint Bucket Tool is used to fill enclosed areas with color, gradients, or bitmap fills.

· The Dropper Tool is used to acquire the color and style information from existing pencil lines, brushstrokes, and fills.

· The Eraser Tool simply erases.

· Normal, Fills, Lines, Selected Fills, Inside

· The Hand acts as a way to move about the Stage rather than the scroll bars.

· The Zoom Tool zooms in on the Stage.

Symbols

· Symbols are objects that a user creates, which are saved and can be reused later in the movie.

· They are important because they minimize movie size, which enables Flash to run faster in a user’s Web browser.

· Creating Symbols

· Press F8 or Insert ( Create Symbol
· They are stored in the movie Library.

· The Library holds all symbols created in a particular movie.

· Common Libraries

· Flash library of symbols

· Double-click the symbol to enter its edit mode.

Types of symbol behavior
Each symbol has a unique Timeline and Stage, complete with layers. When you create a symbol you choose the symbol type, depending on how you want to use the symbol in the movie. 

Use graphic symbols for static images and to create reusable pieces of animation that are tied to the Timeline of the main movie. Graphic symbols operate in sync with the movie's Timeline. Interactive controls and sounds won't work in a graphic symbol's animation sequence.  
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Use button symbols to create interactive buttons in the movie that respond to mouse clicks, rollovers or other actions. You define the graphics associated with various button states, and then assign actions to a button instance 
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Use movie clip symbols to create reusable pieces of animation. Movie clips have their own multiframe Timeline that plays independent of the main movie's Timeline—think of them as mini-movies inside a main movie that can contain interactive controls, sounds, and even other movie clip instances. You can also place movie clip instances inside the Timeline of a button symbol to create animated buttons. 
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Instances

· Instances are a single “instance” of a symbol.

· For example, if you created a symbol of a dog and wanted to use it more than once, every time you used it, it would be an “instance” of the dog.

· Reusing the symbol make Flash movies run much faster than other media such as Windows Media Player and Real Player.

Animations
Flash distinguishes tweened animation from frame-by-frame animation in the Timeline as follows: 

Motion tweens are indicated by a black dot at the beginning keyframe; intermediate tweened frames have a black arrow with a light-blue background.
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Shape tweens are indicated by a black dot at the beginning keyframe; intermediate frames have a black arrow with a light-green background.
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A dashed line indicates that the tween is broken or incomplete, such as when the final keyframe is missing.
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A single keyframe is indicated by a black dot. Light-gray frames after a single keyframe contain the same content with no changes and have a black line with a hollow rectangle at the last frame of the span.
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A small a indicates that the frame has been assigned a frame action with the Actions panel. 
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Flash Objects – objects that can be manipulated using ActionScript

· Text

· Buttons

· Graphics

· Movie Clips

· Mouse

· Math

· Strings

· Many others

· You must name your objects by giving them an instance name.

Object Properties – Each Flash Object has its own set of properties, for example:

· Mygraphic._y – is the y position of Mygraphic.

· Mybutton._alpha – is the transparency of Mybutton.

· Mymovie._visible – is the visibility of Mymovie.

· Many others

· ActionScript can be used to dynamically set these properties for named objects.

Object Methods – Methods perform actions, such as:

· stop() – stops processing of the timeline.

· gotoAndStop(n) – jumps to Frame n and stops.

· gotoAndPlay(n) – jumps to Frame n and plays.

· myObject.nextFrame() – goes to the next frame of myObject.

· Many others

Flash Events – ActionScript can be triggered by events, such as:

· rollover – the mouse rolls over an object.

· rollout – the mouse roll off an object.

· release – the mouse button is released.

· keyDown – a key is pressed on the keyboard.

· Many others
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